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Introduction

"The willingness with which our young people are likely to serve in any war, no matter how justified, shall be directly
proportional as to how they perceive the Veterans of earlier wars were treated and appreciated by their country." George
Washington
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Ever since the founding of our country, over 230 years ago, Americans have proudly stepped forward in times of peace
and war to wear their country’s uniform. They have, through great personal sacrifice, protected the freedoms established
by the Founders of our great nation. Our valiant men and women in uniform today continue this tradition as we fight a
worldwide war on terror.

A grateful nation owes them more than a debt of gratitude and respect. As George Washington observed, it is in the
nation’s best interest to care for those who were willing to enter harm’s way for the sake of their nation and the freedom it
exists to safeguard.

It is the purpose of this handbook to help keep our promise to those loyal and trustworthy men and women of the United
States Armed Forces. To help honor their service and sacrifice, its goal is to provide a better understanding of the ins-and-
outs of the broad range of benefits and services that have earned.
This handbook is presented in three main sections:

1. Pay, Allowances and Retirement

2. Healthcare, Survivors Benefits and Social Security

3. Veterans’ Benefits and Programs

We hope that you find this 2014 United States Military Handbook helpful, and we wish you the very best in your military
career.

— The Military Handbooks Staff
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Military Pay

Understanding military pay is the first step in making sure you receive what you are entitled to. Unfortunately, the military
compensation system — with over 70 different kinds of pay and allowances — is highly complex. The good news is that
everything you need to know is found right here in this handbook.

Annual Pay Adjustment

Generally speaking, annual military pay raises are linked to the increase in private sector wages. Beginning with the
January 1, 2000 pay raise, annual pay raises through 2006 were one-half percent above private-sector average increases as
measured by the Employment Cost Index (ECI). This was an important change. Since passage of a 1990 law, the annual
military pay raise was capped at one-half percent below private-sector growth unless specifically granted a larger increase
by Congress. The FY2000 National Defense Authorization Act directed that pay raises for 2000 through 2006 would
automatically be one-half percent above the private-sector wage increases. Since 2007, pay raises have been equal to the
increase in the ECI. In January 2009, the military pay raise was 3.9% (ECI) while in January 2010, the military pay raise
was 3.4% (ECI). Pay raises may exceed these automatic levels if authorized and funded by Congress.

However, current laws governing annual pay raises no longer guarantee that military pay will be automatically set above
civilian average pay increases. This means military pay raises are determined according to the National Defense budget.

Frequently Asked Questions

How are annual pay raises determined?

ECI is the Employment Cost Index, which is a measure of the increase in private-sector wages and salaries. It is calculated
by the Department of Labor's Bureau of Labor Statistics and updated every three months. President Obama has informed
Congress that there will be a cap of 1% on 2014 pay raise versus the 1.8% raise set by the ECI. (Verified 11-15-13) To
view this year’s Military Pay Table, visit: http://www.dfas.mil/militarymembers.html

Does this affect Federal civilians?

The provision for future military pay increases above ECI does not necessarily pertain to Federal civilian employees. The
pay 2013 tables for Federal civilians may be seen at the Office of Personnel Management web site: http://www.opm.gov/

policy-data-oversight/pay-leave/salaries-wages/#url=2013 (Verified 11-15-13).

Do these future pay raises affect retirees?

No. Retiree Cost-of-Living Adjustments (COLAs) are based on the increase of inflation, which is measured by the
Consumer Price Index (CPI), not ECIL.

What's the difference between CPI (used for retiree increases) and ECI (used for active duty raises)?

CPI, Consumer Price Index, measures inflation. The purpose of using CPI is to generally preserve the purchasing power
of retired pay. ECI, Employment Cost Index, measures private-sector wage increases.

What is the effect of the executive ceiling upon the pay raises?

Pay is still capped for some individuals by law to certain executive pay levels. The cap for basic pay for O-7 to O-10 is
limited to Level II of the Executive Schedule. Basic pay for O-6 and below is limited to Level V of the Executive
Schedule.

Managing Your Pay: The myPay System
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Thanks to technology, you now have much greater ability to manage your pay. The agency responsible for paying
America’s service members is the Defense Finance and Accounting Service (DFAS). On its Web site, this agency provides
a secure site where you can establish an account that you can use to access your latest personal pay information and keep
your pay account up to date. You can manage your pay information, leave and earning statements, W-2's and more.

The Web site where you can create an account is at https://mypay.dfas.mil/mypay.aspx.
Combined Federal Campaign (CFC) Extended
myPay users will be able to make CFC contributions in myPay through midnight eastern time on 01/11/2014. Beginning
01/12/2014, those who still wish to make a CFC contribution should contact a CFC key worker to complete the paper
CFC Donor Pledge Card form. CFC key workers will accept pledge card forms through 1/15/2014.
Setting Up Your Browser:
1) Which browsers can I use to access this site?
* Netscape version 6.1 or later on Windows
* Internet Explorer version 6.0 or later on Windows
* Browsers Blocked from accessing myPay:
Netscape version 6.0 on ALL Operating Systems
Netscape versions prior to 6.1 on ALL Operating Systems

Internet Explorer before version 5.0 on ALL Operating Systems
All browsers without 128-bit encryption on ALL Operating Systems

L

* Browsers Which May Be Used to Access myPay, But for Which No Support Will be Provided by myPay:

All other 128-bit encryption browsers not in the supported or blocked groups above may be used to access
myPay. However, no support will be provided by myPay if there are problems with the browser interacting
with myPay.

NOTE: If you are using special interpretive software, such as a screen reader, in addition to your browser, you should
set the special software to read forms ("forms mode"). If you do not have "forms mode" turned on, you may not be
able to change data items in the myPay online forms. For some software, you can turn "forms mode" on by pressing
the ENTER or RETURN key. Check your software's online help for instructions.

2) Can I use the browser provided by my Internet Service Provider?

If you are using a web browser provided by your Internet service provider or online service, you might not be able
to use the full security capabilities of myPay. (Examples of service providers are America On-Line, CompuServe,
and The Microsoft Network.)

DFAS recommends that you use the official Microsoft Internet Explorer, available from www.microsoft.com, or
Netscape Navigator, available from http://netscape.aol.com/. myPay only supports browsers with JavaScript and
strong encryption enabled.

3) Whatis 128-bit encryption?

In order to use the myPay Web site, you must use a web browser that supports Secure Socket Layers (SSL)
protocol with 128-bit encryption software (strong encryption) and JavaScript enabled. This prevents information
from being read by others on the Internet while it is being transmitted between your web browser and the myPay
Web site. 128-bit encryption is the highest level of encryption available.
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4) How do I know if I have 128-bit encryption?

Because browsers vary, you should see your system administrator, check the manual, use the help option, or call/
e-mail your browser vendor's technical support group to verify that you have 128-bit encryption. If you are unable
to use 128-bit encryption, use the myPay Interactive Voice Response System (IVRS) toll free at 1-877-363-3677,
or commercial at (478) 757-3119. (You cannot reach a customer service representative at these numbers.)

5) Where can I get a 128 bit browser?
Microsoft Internet Explorer is available from www.microsoft.com.

6) How do I enable JavaScript?
Since directions for enabling JavaScript vary across browsers, you should see your system administrator, check
the manual, use the help option, or call/e-mail your browser vendor's technical support group for instructions and
support in enabling JavaScript.

7) What is cache (or caching)?
Browsers can automatically store/save (cache) pages displayed on your monitor to your hard drive. Caching
(automatically saving pages to your hard drive) can allow others to see your personal information if they have
access to your machine. When you are operating in the SSL mode, some browsers allow you to set the cache to be
cleared (deleted) upon exiting the browser. If possible, you should set the cache to be cleared upon exiting the
browser when using myPay.

8) How do I set the browser cache to clear upon exiting?
Since directions for clearing the cache vary across browsers, you should see your system administrator, check the
manual, use the help option, or call/e-mail your browser vendor's technical support group for instructions and
support in setting the browser cache to clear upon exiting. Caching cannot be disabled in every browser, and
disabling the caching feature may prevent you from printing your LES.

Getting Connected
9) How do I access myPay?

If you do not have a myPay PIN; proceed to FAQ # 34 for instructions on how to obtain a PIN.

You can use the Internet or touch-tone telephone to access myPay. On the Internet, you can reach the myPay Web
site at:

1. https://mypay.dfas.mil or
2. http://www.dfas.mil (click on myPay).

NOTE: Web TV users should access myPay through the http://www.dfas.mil site, or go directly to the myPay
home page at https://mypay.dfas.mil/mypay.aspx . Enter your SSN or Alternate ID and PIN and click on the GO
button, your SSN or Alternate ID and PIN will disappear, please scroll down the page for the Main Menu
Selections. You will be able to click on any of the items listed on the menu.

Using a touch-tone telephone, contact myPay at:

0. Ifyou are calling from the continental U.S., call toll-free at 1-877-363-3677
1. Ifyou are calling from outside of the continental U.S., call commercial at (478) 757-3119.

For security reasons, DO NOT use a cellular phone when calling myPay. You cannot reach a customer service
representative at the myPay telephone number.
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For additional information or assistance, contact the DFAS Centralized Customer Support Unit toll free at 1-888-
DFAS411 or 1-888-332-7411, or call commercial at (216) 522-5096, or use the Defense Switching Network
(DSN) at 580-5096. The Customer Support Unit is available Monday through Friday, from 7 A.M. till 6:30 P.M.
Eastern Standard time. You may also contact your customer service representative (see FAQ #19).

10) Why do I keep getting a "Domain Not Found" error?

Check that you are typing https://mypay.dfas.mil/ for the URL (location). Also, there could be a problem with the
domain service or the connection link you are using.

After Accessing the Site:
11) What do I do with Pop-Up Blockers?
Internet Explorer browser users can eliminate the pop-up blocker problem by following these steps:

. Click on the "Tools" menu

. Click on "Internet Options"

. Click the "Security" tab

. Click the "Trusted Sites" icon

. Click the "Sites" button

. Copy https://mypay.dfas.mil into the zone field
. Click the "ADD" button

. Click the "OK" button

O WDN kW~

Mozilla browser users can eliminate the pop-up blocker problem by following these steps:

1. Click on the "Tools" menu

2. Choose "Options"

3. Click on the "Web Features" category

4. Click "Add Site"

5. Copy https://mypay.dfas.mil into the "Add Web Site" field

You can also temporarily disable some pop-up blockers by holding down the CTRL key while you click on the
GO button. This will usually disable most pop-up blockers.

12) Why isn't my pay system accessible?

First, verify that your pay system is available (see FAQ #20). If your pay system is available but is still not listed
your account may not be online due to account maintenance, recent transfer or retirement.

13) Why can't I enter my full Social Security Number (SSN)?
Dashes and special characters are not allowed. Type only the numbers in your Social Security Number.
NOTE: If you are using special interpretive software, such as a screen reader, you should set the special software
to read forms ("forms mode"). If you do not have "forms mode" turned on, you may not be able to change data
items in the myPay online forms. For some software, you can turn "forms mode" on by pressing the ENTER or
RETURN key. Check your software's online help for instructions.
System Privacy

14) How private is my data in myPay?
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In order to protect our customer’s privacy, myPay masks Passwords. myPay also masks the first five positions of
the SSN on the display and print of pay account statements and travel vouchers. The advantage of using the On-
Screen Keyboard, with keys that display in random order each time you log on, is that others are deterred from
learning your Password.

Privacy Act Statement: The information you provide to the myPay system is covered by the Privacy Act of
1974. To receive a copy of the Privacy Act Statement for the actions you enter into the system, please see your
Local Finance Office or your Customer Service Representative.

AUTHORITY: Title 5 U.S.C. Chapters 53, 55 and 81; Title 10 U.S.C. Chapters 11, 61-73; Title 37 U.S.C.; GAO
Manual for Guidance of Federal Agencies, Title 6, Chapter 4, para. 4.2.B.2; and E.O. 9397

PRINCIPAL PURPOSES: Information is collected to allow Army, Navy and Air Force active and reserve
military paid by the Defense Joint Military Pay System (DJMS); active and reserve Marines paid by the Marine
Corps Total Force System (MCTES); civilians paid by the Defense Civilian Pay System (DCPS); and retirees/
annuitants paid by the Defense Retiree/Annuitant Pay System (DRAS) to execute changes to certain payroll
information and to validate the employee in the event he/she needs to reestablish a Password.

ROUTINE USES: Payroll data will be disclosed to financial institutions or other entities as designated by the
employee to receive such information.

DISCLOSURE: Voluntary. However, if the employee fails to provide the information requested, DFAS will not
be able to process the request. DFAS is authorized to collect and use this information based on the myPay Privacy
Act systems notice that is published in the Federal Register, (71 FR 34898, June 16, 2006). The system identifier
is T 7336.

System Security
15) How secure is my data on myPay?

This is a Department of Defense (DOD) computer system. This computer system, which includes all related
equipment, software, networks, and network devices, is provided only for official U.S. Government business.

DOD computer systems may be monitored by authorized personnel to ensure that their use is authorized to
manage the system, to facilitate protection against unauthorized access, and to verify security procedures. During
these activities, information stored on this system may be examined, copied and used for authorized security
purposes, and data or programs may be placed into this system. Use of this or any other DOD interest computer
system constitutes consent to monitoring at all times.

The unique combination of Login ID, Password / PIN used to access myPay makes myPay as secure as using an
automated teller machine (ATM) at a bank. myPay users must use a browser with Secure Socket Layers (SSL)
protocol with 128-bit encryption software (strong encryption). This combination prevents information from being
retrieved by someone else while it is being transmitted.

While myPay uses a variety of security features to protect your data in our system, it is also important that you do
everything you can to protect data from being compromised or captured on your computer, especially when using
personal computers at home. Here are several things you should consider to protect your data not only when using
myPay, but any electronic commerce activity (e.g. on-line banking, credit card purchases, etc.):

1. Install operating system and application software (e.g. Internet Explorer) updates regularly. Many of
these updates are issued to fix security problems which have been identified.

2. Install and use anti-virus software and personal firewalls. Keep this software updated. The correct use of
these programs can help protect your system from being compromised by malicious software (e.g.
software which can capture information processed on your computer, etc). The DOD CERT makes this
type of software available for DOD active employees (military and civilian) at: a.www.jtfgno.mil

(This link can only be used from a Department of Defense computer)
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3. Do not store your various User-IDs and passwords in files on your computer. If someone gains access to
your computer this is the type of information they look for and would aid them in accessing your account.

4. After using your browser (e.g. Internet Explorer, etc) to access a site where you process sensitive
information (e.g. myPay, your bank account, etc.) close all of your browser windows and restart a new
browser session. Sometimes the browser can hold that information in memory (e.g. cache, etc) and some
web sites know where to look to find it.

5. Be very careful when installing software that gives others access to your computer. Remote service
software or peer-to-peer software used for file sharing can create unintended openings into your computer
that outsiders can use if the software is not configured correctly.

System Availability

1) myPay has periods of unavailability due to scheduled DFAS pay system maintenance windows, as

shown below. All times are Eastern Time.

[Pay System Days Times (Eastern Time)
All Daily (Except Saturday and Sunday) 12:00 A.M. - 1:00 A.M.
All Marine Corps Every Friday for LES and W-2 10:00 P.M.- 4:00 A.M. (SAT))
Every Friday for Transactions 11:00 P.M.-8:00 A.M. (SAT))
2) Where can I find more information about the Defense Finance and Accounting Service (DFAS)?

You can access the DFAS web page at: www.dfas.mil for more information.

About myPay

3)

4)

5)

6)

7)

What is myPay?

myPay is an innovative, automated system that puts you in control of processing certain discretionary pay data
items without using paper forms. You can also get your pay and tax statements, and travel advice of payment
using myPay.

Why should I use myPay?

myPay saves time. myPay eliminates the need to write letters or fill out forms by letting you make your own
changes immediately with user-friendly technology.

myPay is convenient. You can access myPay nearly 24 hours a day, 7 days a week to change or review your
current information, or to check your most recent pay statement.

myPay is reliable. myPay has the same procedural checks for accuracy as the paper forms.

When is myPay available?

myPay is available nearly 24 hours a day, 7 days a week. Refer to FAQ # 16 for the exceptions to this availability.
Which pay changes can I make using myPay?

You can change a variety of discretionary payroll items. You can get a current list of the items you can change
from myPay, your servicing payroll office, or your customer service representative.

When will my changes be effective?

Upon completion and acceptance of a change, myPay will display a "NO LATER THAN" date. Your change will
be effective on or before the date myPay displays.
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Annuitants, Military (all services & components), Civilians and Retirees: You can verify the change to your
account by accessing myPay three to seven business days after you make the change, or by contacting your
customer service representative (see FAQ #19).

8) How will I know that my change was made?

In keeping with government streamlining efforts and to reduce the use of paper, myPay takes advantage of
existing technology and is paperless, so you will not receive any written confirmation. However, myPay
displays a "NO LATER THAN" date before and after your change is accepted. Any change you make to your
account should be posted no later than this date. You must receive this notification message to ensure that your
action has been accepted. If your change does not appear on your account by then, contact your customer service
representative. If you have a registered email address, an email notification will be sent when the transaction is
sent to your pay system for processing.

* Military (Active and Reserve), and Civilians:_You may check your Leave and Earnings Statement
(LES) to verify that your change was processed.
Annuitants: You will receive a pay statement in the mail each time you make a change to your account.
Retirees:_If you make a change to your allotments or federal tax withholding amount, you will receive a
Retiree Account Statement (RAS) in the mail reflecting the change in your net pay unless you have
elected to receive your RAS electronically.

9) Reserved for future use.

10) I am in a tax exempt status. How does this affect changes I wish to make to my federal taxes?
* Civilians: If you filed a W-4 to be in a tax-exempt status, you are not allowed to make federal tax

changes.

All Military Members except for Cadets/Midshipmen and Retirees: With the exception of special

statuses, you are allowed to make federal tax exemption changes using myPay.

11) I entered an amount in the federal tax additional withholding amount block. How much money will
actually be deducted from myPay each payday?
* Civilians: The amount that will be deducted each pay period will be the additional amount entered in
addition to the tax withholding based on your current filing status (marital status and exemptions).
All Other Employees/Members except for Former Spouse and Cadets/Midshipmen: The amount you
enter will be deducted each month, (one-half each payday if you have two paydays per month) in addition
to the tax withholding based on your current filing status (marital status and exemptions).

12) Can I change my financial allotments?
* All Active Military Members, Military Retirees, and Civilians: You can change your direct deposit
financial allotments using myPay.

Warning: Court /support agencies require a case number for payment transactions. You cannot enter a
case number and additional information using myPay. Please see your service payroll representative to
change any court ordered child/alimony support payments.

Annuitants, Former Spouse and Cadets/Midshipmen: This option does not apply to you.

13) Is there a maximum amount for my financial allotments (including new allotments and increases)?

* myPay allows eligible employees/members to start or increase a financial allotment for any amount as

long as it does not exceed the amount of available net pay.
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Civilian employees should determine their net pay amount before starting any allotments to ensure that
existing allotments are not affected by any new allotments.

14) How many financial allotments can I start?

* Active Duty Members and Retirees: You are limited by DoD regulations in the number of allotments
that you can start.

Warning: Court /support agencies require a case number for payment transactions. You cannot
enter a case number and additional information using myPay. Please see your service payroll
representative to start any court ordered child/alimony support payments.

Civilians: myPay will allow you to start a maximum of seven financial allotments.
Annuitants, Former Spouse and Cadets/Midshipmen: This option does not apply to you.

15) What should I do if I find out the change I made on myPay was incorrect or was not the change that I
wanted to make?

Any changes you make using myPay can be corrected using myPay at any time. Please submit your change only
once. The change will post according to your pay system's update schedule.

16) What information do I need to be able to use myPay?

The first time you access myPay you will still need to enter your Social Security Number (SSN) or Login ID and
PIN. You will be prompted to create a Login ID (if you are using your SSN) and a Password. The Login ID and
Password will be entered on the home page. You may use an On-Screen Keyboard for additional security.
Depending on what you want to do in myPay, you may need additional information.

When a military member retires or transfers to the reserves, the retiree or reserve member may continue to
use the same Password that they used while on active duty to access their myPay retired or reserve pay
account information.

Login ID
17) What is my Login ID?

Your Login ID will be 6-129 positions of your choosing, containing letters, numbers, and certain special
characters. The Login ID will not be masked. You might want to use your email address for your Login ID or
some other combination of characters that you will remember.

You cannot use 9 numbers for the Login ID.

The Login ID may not contain spaces.

The Login ID must not be less than 6 characters and no more than 129 characters.

For a Login ID using an email address, the email address can be no more than 129 positions.

You will not be allowed to use the same Login ID that someone else is using.

The Login ID may contain alphabetic (letters) and/or numeric characters and may also contain the
following special characters:

@ (at sign)

_ (underscore)
- (dash)

. (Period)
‘(Apostrophe)
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If you were given a Limited Access Password by a myPay customer, you will also be provided your own Login ID
from the myPay customer once they have established one for you.

18) What can I do if I forget my Login ID?

There is a “Forgot Your Login ID" link on the home page. When you click on it you will be provided instructions

to retrieve your Login ID. You will be asked to enter your previously registered email address and Social Security
Number and then your Login ID will be emailed to you. If you do not have a registered email address, you will be
asked for your Social Security Number and Password.

About your myPay Password
19) How do I get a Password

If you do not know, have not received or have suspended your temporary or customized Password, you can reset
your myPay Password online by correctly replying to 3 of the 8 Security Questions you have set up, after clicking
on the “Forgot or Need a Password” hyperlink on the myPay home page

Before you set up the questions, or if you fail to correctly answer the questions, you may request a new temporary
Password.

Security Restrictions allow Passwords to be emailed only to addresses that have been pre-registered from the
appropriate administrator or to a pre-defined Personal Email address you provided previously in myPay.

If you do not have a pre-registered email address, you can request that a password be mailed to you. The new
temporary Password will be mailed to your address of record in your pay system. Password letters will be mailed
within two business days. Delivery time will vary based upon your location and postal service volume. If you do
not receive your Password letter within ten business days, please verify your mailing address with your pay
system.

If we cannot mail/email a new random temporary Password to you, the screen will display other procedures for
obtaining a new Password.

If you need additional assistance with obtaining a Password, please contact the Customer Support Unit Toll Free
at 1-888-DFAS411 or 1-888-332-7411, Commercial 216-522-5096 or Defense Switching Network (DSN) at
580-5096.

20) What may I use for a Password
The myPay has changed to a stronger password.
The Password must:

be 15 to 30 characters in length

contain at least two UPPERCASE letters (A-Z)

contain at least two lowercase letters(a-z)

contain at least two numbers (0-9)

contain at least two of the following special characters: # @ $ * ! * +=_ %
change at least four characters from the previous password.

The PASSWORD CANNOT:
* contain spaces
be one of your last 10 previous passwords
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Your PASSWORD will expire in 60 days. Avoid creating passwords that use:

Dictionary words in any language

Personal Information. Your name, birthday, driver's license, passport number, or similar information.
Sequences or repeated characters: Examples: 12345678, 2222222, abedefg, or adjacent letters on your
keyboard (qwerty).

21) Can I change my Password or PIN?

Yes. You can change your Password or PIN at any time. Click on the Personal Settings page for the Change
Password and Change PIN options.

On-Screen Keyboard
22) What is an On-Screen Keyboard?

The On-Screen Keyboard is one of many Security features myPay has introduced to protect your data in our
system. The advantage of using the On-Screen Keyboard, with keys that display in random order each time you
log on, is that others are deterred from learning your Password.

When Java-Script is enabled, each time you arrive at myPay and enter your Login ID, you will be presented with
the option to use the On-Screen Keyboard to enter your Password. You’ll use your mouse with the On-Screen
Keyboard to enter the characters contained in your Password.

To log in to myPay using the On-Screen Keyboard with a mouse:

1. Type your Login ID under Account Access on the myPay Home Page and click on On-Screen
Keyboard hyperlink.

2. Next, click on the appropriate numbers, letters and special characters of your Password using the On-
Screen Keyboard. Your Password will be masked in the text box. When you have finished, click the
"Accept/Submit" button. Remember to select the Uppercase/Lowercase button when appropriate

3. If you enter an incorrect number, letter or special character using the On-Screen Keyboard, click on the
On-Screen Keyboard Backspace button to erase the last position entered. If you want to clear all the
numbers/letters/special characters that you have entered, click on the Clear button on the On-Screen
Keyboard. You can also tab to the On-Screen Keyboard Backspace button. Clear or UPPERCASE/
lowercase button and select the button by pressing the space bar.

If the On-Screen Keyboard is not visible on the home page, please try the following steps:

1. Go to the Internet Browser Tool Bar

2. Select TOOLS

3. Click on INTERNET OPTIONS

4. Click on GENERAL TAB

5. At Temporary Internet Files Section, Click on DELETE FILE (a new box appears)
6. Click on DELETE ALL OFFLINE CONTENT

7. Click on OK (this step clears cached memory and removes all old internet files)

8. From the Internet Browser’s Tool Bar, Click on TOOLS

9. Click on INTERNET OPTIONS

10. Click on the ADVANCED TAB

11. Scroll down to SECURITY

12. Check the option to EMPTY TEMPORARY INTERNET FILES FOLDER when browser is closed.
13. Click on OK

14. Close the browser
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15. Now reopen the browser and the On-Screen Keyboard will appear.
Limited Access Password
23) What is a Limited Password?

The Limited Access Password may be given to one or multiple individuals along with a Login ID to view your
pay and tax statements without allowing them to create any pay changes. You may establish a Limited Access
Password and Login ID by clicking on the Personal Settings Page option on the main menu, then selecting the
Limited Access option. You may delete users' Limited Access at any time. If the user suspends their Limited
Access Password you must establish a new Limited Access Password and provide that new Password to the user.

24) What may I use for Limited Access Login ID and Password?

The Limited Access Login ID must not match your Login ID. The other requirements for a Limited Access Login
ID are the same as for your Login ID. The requirements for the Limited Access Password are the same as for your
Password except that the Limited Access Password cannot match either your Login ID or the Limited Access
Login ID. The Limited Access Password will expire every 60 days and the individual that you have given it too
will be prompted to change it when they access myPay and the password has reached its 60 day expiration. The
LIMITED ACCESS PASSWORD must:

be at least 15 to 30 characters in length

* contain at least two UPPERCASE letters (A-Z

contain at least two lowercase letters (a-z)

contain at least two numbers (0-9).

contain at least two of the following special characters: # @ $ * ! * +=_ %
change at least four characters from the previous password

The PASSWORD CANNOT:

contain spaces
be one of the last 10 previous passwords

The password will expire in 60 days.
Email Addresses

25) Why am I prompted to review my email address?
You will be prompted to review your email address(es) yearly so that we know your email address is correct.

DFAS strives to notify customers of issues related to your pay account and most importantly we want to be able to
send you a password if you need your password reset.

26) How do I correct my workplace email address if it is invalid or identified as a multiple?

DFAS has a workplace email address on file for you that cannot be used because it was registered to you in error
by your email administrator. Please contact your Email Administrator if you have questions and to correct your
email address. You may select Email Address on the Main Menu to review the email addresses and providers of
those addresses that we have on file for you

If you are a Veterans Affairs employee and your email address is incorrect, you will need to contact your local
Human Resources office and they will update your email address.
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If you have an email address that is USMC.mil, AF.mil, or Navy.mil, Army.mil or DFAS.mil, you may also add a
valid .mil workplace email address as your personal email address if it is not posted to your myPay account.
If your workplace email address is invalid or already in use:

* To correct your ID/CAC card email address, please contact your RAPIDS Station point of contact,
Personnel Center or the DMDC Help Desk at (800) 538-9552 to have your record corrected.

* To correct a Defense Information Systems Agency (DISA) email address, go to www.disa.mil, click on
"My Profile". Updating it there will update it in myPay approximately the first of each month.

* To correct an Army AKO email address (us.army.mil), contact your local site’s email administrator or go
to www.us.army.mil. myPay updates these email addresses weekly.

* To correct a DFAS.mil, contact your local site’s email administrator. myPay updates these email addresses
weekly.

* To correct an AF.mil email address, contact your local site’s email administrator. myPay updates these
email addresses weekly.

* To correct a Department of Energy (DOE) email address, access DOE's Employee Self Service (ESS) site
to make that change. myPay updates email addresses weekly from that site.

Assistance/Customer Support
27) What kind of help does the DFAS Centralized Customer Support Unit provide?

For problems using myPay, or with your myPay PIN, contact the DFAS Centralized Customer Support Unit toll-
free at 1-888-DFAS411 or 1-888-332-7411 or commercial at (216) 522-5096 or Defense Switching Network
(DSN) at 580-5096. This support line is available Monday through Friday, 8:00 A.M. to 5:00 P.M. Eastern
Standard Time.

The Centralized Customer Support Unit can provide assistance on how to use the options available to you in
myPay. The Centralized Customer Support Unit will also provide support for establishing and changing your PIN.

For ALL other payroll information please contact your servicing pay office or your customer service
representatives.
28) Who can help me with my pay account?

Questions concerning SPECIFIC PAY ACCOUNT INFORMATION should be directed to the servicing payroll
office or to your normal customer service representative as follows:

Civilian Employees 'Your local Customer Service Representative

Military Retirees 1-800-321-1080

Annuitants 1-800-321-1080 (US) or (216) 522-5955 (Outside US)

Military Former Spouses [1-888-DFAS411 or 1-888-332-7411, DSN 580-5096

Military Members:

U.S. Air Force Active 'Your Local Finance Office

U.S. Air Force Reserves  [Your Local Reserve Center Finance Office

U.S. Army Active 'Your servicing Defense Military Pay Office or Finance Battalion

U.S. Army Reserves 1-888-DFAS411 or 1-888-332-7411, DSN 580-5096 or your administrative unit
U.S. National Guard 1-888-DFAS411 or 1-888-332-7411, DSN 580-5096 or your administrative unit

U.S. Army Separatees 1-888-DFAS411 or 1-888-332-7411, DSN 580-5096
U.S. Marine Corps Active [Your Local Admin Office

U.S. Marine Corps 'Your Local Admin Office

Reserves

U.S. Navy Active 1-888-DFAS411 or 1-888-332-7411, DSN 580-5096 or your Local Personnel Support
IDetachment

U.S. Navy Reserves 1-888-DFAS411 or 1-888-332-7411, DSN 580-5096 or your Local Reserve Personnel
Support Detachment

INAF Employee 'Your local administrative office.

25
www.militaryhandbooks.com 2014 United States Military Handbook


http://www.disa.mil/
http://www.disa.mil/
http://www.us.army.mil/
http://www.us.army.mil/

Travel voucher status is available at 1-888-332-7366 (option 1) or DSN 699-0300 for OCONUS travelers.

Military Retirees that are in a non-pay status due to a VA Waiver or Combat Pay can still access myPay but will
have limited options available. Questions should be referred to the customer service previously listed.

LES or Pay Statement display and delivery
29) May I view and print my Leave and Earning Statement (LES) or Pay Statement online?
All Active/Reserve Military and Civilians: You can view and print your Leave and Earnings Statement (LES) on-
line. You may access your LES from the "Main Menu" by clicking on the Leave and Earnings Statement (LES)
option. If you have trouble reading the graphic version of your LES, you can click on the "Text Version" link. The
text version of your LES lists all your LES pay data items in a single column.

Your LESs will remain available for a temporary period of time after your separation.

For Non Appropriated Fund employees: Your last 26 LESs will remain available until they have cycled off
through normal monthly updates.

For Army, Navy and Air Force (Active): Your last 12 LESs will remain available until they have cycled off
through normal monthly updates, or you have separated from military service.

For Army, Navy, and Air Force (Reserve): Your LESs for the last 13 months will remain available until they
have cycled off through normal monthly updates.

For Marines (Active and Reserve): Your last 12 LESs will remain available until they have cycled off through
normal monthly updates.

For Civilians: Your last 26 LESs will remain available until they have cycled off through normal pay period
updates.

Annuitants and Retired Military: You can view and print your account statements on-line. If you have trouble
reading the graphic version of your account statement, you can click on the "Text Version" link. The text version
of your account statement lists all of your pay data items information in a single column.

Former Spouses: You can view and print your Pay Statements on-line. You may access your Pay Statement from
the “Main Menu” by clicking on the Payment Information option. If you have trouble reading the graphic version
of your Pay Statement, you can click on the “Text Version” link. The text version of your Pay Statement lists all of
your pay data items information in a single column.

30) Will I continue to receive my hard copy Leave and Earnings Statement (LES) or Pay statement?
Service or Agency Policy will determine if delivery of your hard copy Leave and Earnings Statement (LES) or
pay statement will remain the same. However, if you like viewing and printing your LES electronically, you can
use myPay to stop the delivery of your hard copy LES or pay statement. (Not available for Former Spouses)

31) How do I stop delivery of my hard copy LES or Pay statement?

You will find the option to stop the hard copy delivery of your LES or pay statement on the Main Menu. (Not
available for Former Spouses)

32) Once I have elected to stop hard copy delivery, can I start it back up later?
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Yes. Using the same process described above, you can re-start the hard copy delivery of your LES or pay
statement. Service or Agency Policy will determine if delivery of your hard copy Leave and Earnings Statement
or pay statement will resume.

33) Can I print my LES or Pay Statement?
Yes. There are instructions under Help on how to print your LES or Pay Statement.
34) I am having problems printing my LES or Pay Statement. What should I do?

DFAS recommends that you select the Printer Friendly Version of your LES if you desire to print or save your
LES. It requires Adobe Acrobat Reader. Often, Acrobat Reader is already added to web browsers. If you don't
have Adobe Reader and applicable security policies allow you to install it, it can be downloaded at http://

www.adobe.com/products/reader.html.

If you prefer the HTML version, you can print it. However, you may have to make adjustments to your margins in
your browser Page Setup for optimal printing of the HTML version. If your LES or Pay Statement is cut off at any
margin, go to the myPay Home Page to adjust the margins of your browser. Once the myPay Home Page is
opened, access the "File" dropdown menu and select "Page Setup". Within the "Page Setup" window, adjust the
left and right margins to .25 inches and the top and bottom margins to .5 inches. If that does not solve the
problem, click on the View menu, Select "Text Size", and click on medium. If you continue to have the problem
after following the above instructions, click on the Tools menu, select "Internet Options", click the General Tab,
click the Fonts button, select "Latin Based", select "Arial Narrow" or "New Times Roman" and click OK and
click OK.

For all other printing issues, please contact the DFAS Centralized Customer Support Unit toll free at 1-888-
DFAS411 or 1-888-332-7411, or commercial at (216) 522-5096, or Defense Switching Network (DSN) at
580-5096.

35) Can I save my LES or Pay Statement as a file on a disk, instead of printing it?
We recommend that you select the Printer Friendly Version of your LES if you desire to print or save your LES. It

requires Adobe Acrobat Reader. Often, Acrobat Reader is already added to web browsers. If you don't have Adobe
Reader and applicable security policies allow you to install it, it can be downloaded at http://www.adobe.com/

products/reader.html.

If you prefer the HTML version and you are using Internet Explorer version 5.0 or higher, you can save your LES
or Pay Statement as an HTML file on a disk or your hard drive by using the Save Option button displayed above
your LES or Pay Statement. Follow the screen instructions displayed by your browser.
Tax Statements
36) May I view and print my tax statement on-line?

This option is available to view and print your tax statements.

You may also view and print your Travel W-2 (Do-It-Yourself, Permanent Change of Station, and Temporary
Duty) and Miscellaneous W-2 (loan repayments, suggestions awards, referral bonuses and back pay).

These options are not available for Former Spouses.
The Travel and Miscellaneous W-2 options are not available for Broadcasting Board of Governors, Department of

Energy, and Environmental Protection Agency, Health and Human Services, Veterans Affairs and Non-
Appropriated Fund employees.

www.militaryhandbooks.com 2014 United States Military Handbook


http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html
http://www.adobe.com/products/reader.html

For Active/Reserve Military: You may view, print and save your W-2 Wage and Tax Statement on-line. You may
access your W-2 from the “Main Menu” by clicking on the Tax Statement (W-2) option. If you have trouble
reading the graphic version of your W-2, you can click on the “Text Version” link. The text version of your W-2
lists all your W-2 data items in a single column.

Army Active, Army Reserve and Army Guard soldiers are able to view, print and save their Student Loan
Repayment Program (SLRP) tax statements on myPay.

Annuitants: You can view, print and save your tax statement. The tax statement displayed on myPay is the end of
year tax statement. Additionally, if the tax statement displayed is incorrect, please contact your customer service
representative.

For Civilians: You can view, print and save your tax statement. The tax statement displayed on myPay is the end
of year tax statement. Additionally, if the tax statement displayed is incorrect, please see your customer service
representative.

Non Appropriated Fund employees: You can view, print and save your tax statement. You may access your W-2
from the “Main Menu” by clicking on the Tax Statement (W-2) option. Any corrected tax statements issued will
not be reflected in myPay. Additionally, if the tax statement displayed is incorrect, please see your installation
representative

Retirees: You can view, print and save your tax statements. The tax statement displayed on myPay is the end of
year tax statement. Additionally, if the tax statement displayed is incorrect, please contact your customer service
representative.

All

DFAS recommends you use the Printer Friendly version of your tax statement. For Printer Friendly information,
please see FAQ # 54.

If Acrobat Reader is not available to you or you prefer HTML, you can print the HTML version of your tax
statement. Follow these instructions. The appearance of the tax statement varies according to the Browser used
and your PC's resolution. You will have to adjust your Page Setup for the best printing results. For Internet
Explorer, begin with setting the Top and Bottom margins at ".50" inches and the Right and Left margins at ".25"
inches. For printing the W-2C on Internet Explorer, begin with setting the Top and Bottom margins at ".80" inches
and the Right and Left margins at ".25" inches.

For Internet Explorer if you see a URL, page number, etc. on your printed copy, use Page Setup to clear out the
Header and Footer information. Most Browser defaults are set to capture this information so that when an
individual prints from the Internet, they will know where the printed data came from. Finally, if you do not want
to print the "Back" and "Print" buttons on an extra page, count the number of W-2/W-2C Forms displayed. For
every 2 forms displayed there will be one print page. Example, if you have 4 W-2 Forms displayed, the current
setup will print 2 on page 1, 2 on page 2, and the Buttons on page 3. So if you set the print range to print only
pages 1 through 2, you save a page that contains only the 2 buttons.

Before filing your tax return, carefully separate the copies printed on a single page. When filing your tax return,
you are not required to include/send the instructions on the back of the tax statement.

For all other printing issues, please contact the DFAS Centralized Customer Support Unit toll free at 1-888-
DFAS411 or 1-888-332-7411, or commercial at (216) 522-5096, or Defense Switching Network (DSN) at
580-5096.

You will be able to access myPay and view your W-2 for one (1) year after you are no longer in a pay status
or separated.

37) How do I stop delivery of my hard copy W-2?
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Most users have the option on the Tax Statement screen as well as on the main menu. Exceptions are Annuitants,
Army Student Loan Repayment Program participants, and Travel/Miscellaneous W-2 recipients, for whom there
is no option to turn on/off hard copies.

Changing your election to electronic processes the transaction for your pay system that will turn off the hard copy
delivery of your Tax Statement.

38) Once I have elected to stop hard copy of delivery of my W-2, can I start it back up later?

Annually during the period December 1 through January 31, no change can be made to the W-2 delivery method.
Using the same process described above, you can make changes to the W-2 delivery method outside of the above
"no change" period.

Changing your election to hard copy processes the transaction for your pay system that will re-start the hard copy
delivery of your Tax Statement.

Printer Friendly Version
39) How do I use the Printer Friendly Versions for my account and tax statements?

DFAS recommends that you use the Printer Friendly Version of your account and tax statements. The Printer
Friendly Version of your account and tax statements is available by clicking the "Printer Friendly" button. It
requires Adobe Acrobat Reader. Often, Acrobat Reader is already added to web browsers. If you don't have Adobe
Reader and applicable security policies allow you to install it; it can be downloaded at http://www.adobe.com/

products/reader.html.

Some Internet Explorer users may encounter one of the following problems when they attempt to use the Printer
Friendly Version. Some may see a File Download dialog box and others may see an error message, "Internet
Explorer cannot download...". Both conditions can be addressed by following these steps:

. Click the Tools Menu at the top of your Internet Explorer browser.

. Click "Internet Options".

. Click the Advanced tab.

. Scroll down until you find the "Do not save encrypted pages to disk".
. Remove the checkmark from the box adjacent to that text.

. Click the Apply button.

. Click the OK button.

NN AW =

Before filing your tax return, carefully separate the copies printed on a single page. When filing your tax return,
you are not required to include/send the instructions on the back of the tax statement.

For all other printing issues, please contact the DFAS Centralized Customer Support Unit at 1-888-DFAS411 or
1-888-332-7411, or commercial at (216) 522-5096, or Defense Switching Network (DSN) at 580-5096.

Thrift Savings Plan (TSP)
40) What TSP transactions can be made via myPay?

TSP via myPay is available only to Active/Reserve Military Members, Health and Human Services (HHS)
employees, Environmental Protection Agency (EPA) employees and Veterans Affairs (VA) employees.

The following transactions can be made:
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* Ifyou are eligible, you can start, change or stop your TSP at any time throughout the year. If you make a
financial hardship withdrawal, you may not make contributions for six months following withdrawal.

41) When can I sign up for the TSP?

If you are eligible, you can sign up to contribute to the TSP at any time. Roth TSP elections for Air Force, Army
and Navy will be accepted on and after October 1, 2012.

42) Where can I get a TSP form?
Changes to your TSP can be made through myPay and do not require a form. However, if you prefer to submit a
paper form (available on the TSP Web site, at (www.tsp.gov ) or if you are interested in a loan, you must contact
your servicing personnel-payroll office.

43) What is the percentage of contribution that I can elect?

Select the TSP option from your Main Menu and refer to the information provided on the TSP page for your
service.

For Marines contributing to TSP: when you reach the IRS maximum amount for the year, the TSP contribution
will be automatically suspended. No action is necessary. January of the following year, your TSP contributions
will be unsuspended and contributions will automatically begin again. No action is necessary.

Internal Revenue Code section 402(g) and section 415(c) may limit your annual contributions. See the Summary
of the Thrift Savings Plan for the Uniformed Services for more information about these statutory limitations.

44) How can I make fund allocation changes?

myPay does not allow you to change the investment of your contributions. To change the investment of your
contributions, you may visit the TSP web site at http://www.tsp.gov. For more information on changing your

TSP contributions, see the Retirement Thrift Investment Board (FRTIB) website.

Direct Deposit

45) What are the different types of Direct Deposit categories?
NET PAY EFT: Your Current Direct Deposit Information for your Paycheck.
TRAVEL EFT: Your Current Direct Deposit information for your Travel Pay (Army Active and Reserve only).

MISCELLANEOUS EFT: Your Current Direct Deposit information for your Miscellaneous Reimbursements
(Army Active and Reserve only).

All EFT options provide the capability to View/Change the Financial Institution, account type and account
number.

If you are starting or changing a Direct Deposit and your new routing transit number (RTN) does not work, please
verify the number with your financial institution. If the number is valid, please notify the DFAS Centralized
Customer Support Unit toll free at 1-888-DFAS411 or 1-888-332-7411, or commercial at (216) 522-5096,
or Defense Switching Network (DSN) at 580-5096 of the discrepancy.

Savings Bonds

46) How do I purchase Savings Bonds in myPay and how do I request Bonds held in safekeeping?
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Effective September 30, 2010, the Department of Defense no longer sells U.S. Savings Bonds through payroll
deduction. You no longer can purchase Savings Bonds using the myPay Savings Bond option.

If you wish to start or continue purchasing Savings Bonds through payroll deduction, you must establish an
account through http://www.treasurydirect.gov/. Then you may use myPay to start an allotment to
TreasuryDirect by clicking on the allotment option at the Main Menu.

INFORMATION FOR BONDS HELD IN SAFEKEEPING FOR MILITARY MEMBERS:

All bonds being held in safekeeping as of the above date for ACTIVE DUTY MEMBERS will continue to be held
until they are requested.

The request must include the service member’s name, complete Social Security Number, a valid address where
the member would like the bonds to be mailed, a daytime telephone number, and the member’s dated signature.
The request must indicate that the member wants the bonds released from safekeeping. Thirty days must be
allowed before a member can claim non-receipt of a bond.

Navy members may submit their signed request in writing or by fax to:

DFAS-Cleveland Center
ATTN: CODE JDCAB
1240 East 9th Street
Cleveland, OH 44199

FAX: 216-522-6358 OR DSN 580-6358
PHONE VOICE: 216-522-5880
DSN VOICE: 580-5880

Marine Corps members may submit their signed request in writing or by fax to:

DFAS-Cleveland Center
ATTN: CODE JDCAB
1240 East 9th Street
Cleveland, OH 44199-2055

FAX: 216-522-6358 OR DSN 580-6358
PHONE VOICE: 216-522-5880
DSN VOICE: 580-5880

Army members may submit their signed request in writing, fax, or by email to:

Center Collection Mailbox
3801 Center Collection

P.O. Box 269490
Indianapolis, IN 46226-9490

FAX: 317-212-4339 or DSN 699-4339
PHONE VOICE: 317-212-8539

DSN VOICE: 699-8539

EMAIL: dfas-incdsbonds@dfas.mil

Air Force members may submit their signed request in writing, fax, or by email to:

Center Collection Mailbox
3801 Center Collection
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P.O. Box 269490
Indianapolis, IN 46226-9490

FAX: 317-212-4339 or DSN 699-4339
PHONE VOICE: 317-212-8539

DSN VOICE: 699-8539

EMAIL: dfas-incdsbonds@dfas.mil

State Taxes
47) What type of state tax changes may I make in myPay?

If you have a state tax option, and your state taxing authority has an agreement with the Department of Defense,
you will be able to use myPay to change your state tax withholding.

For Civilians, you now have the option to change your state taxing authority. You must select a state from the drop
down menu.

Military (Active and Reserve), you will not be permitted to add or change a state tax authority. To change your
state tax authority you must see your customer service representative or local finance office.

Travel Advice of Payment (AOP)
48) What is Travel Advice of Payment (AOP)?

The Travel Advice of Payment (AOP) option provides myPay users with the capability to view and print their
processed TDY Travel Vouchers on-line.

Travel voucher status is available at 1-888-332-7366 (option 1) or DSN 699-0300 for OCONUS travelers.

For travel vouchers submitted to Air Force Finance Offices, contact your local FSO instead for your voucher
status.

49) May I view and print my Travel Advice of Payment (AOP) statement on-line?

You may access your AOP from the "Main Menu" by clicking on the "Travel Voucher Advice of Payment” AOP
option. If you have any trouble printing your Travel AOP, refer to the suggestions in FAQ #42.

In general, DFAS Indianapolis processes vouchers for Army military and civilian employees, while DFAS
Cleveland processes vouchers for Navy and Marine Corps military and civilian employees, DFAS Columbus
processes vouchers for DFAS civilians and civilian employees from other Defense Agencies. Air Force vouchers
are processed by the Air Force. Effective August 2013, Air Force vouchers paid through the Reserve Travel
System are available on myPay.

Effective September 19, 2005, Defense Travel System (DTS) vouchers are available for the Air Force, Army,
Navy, Marines and Civilians. The AOP produced by DTS currently does not contain a breakdown of the daily Per
Diem amounts and the Reimbursable Expenses.

If you need more information about which Center pays your voucher, or if you have questions about whether or
not your voucher will be available based on the voucher number, please contact your local travel office.

50) Will all of my Travel Advice of Payment (AOP) statements be available?

NO. myPay will make travel vouchers available for six months from the date the voucher was paid. Once a
voucher is older than six months, that particular voucher will not be available in myPay.
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Although the vast majority of vouchers processed by DFAS-Indianapolis and DFAS-Columbus are available,
there are some "rare" travel vouchers that will not be on line for these centers.

Savings Deposit Program

51) Who should I contact if I have questions about my Savings Deposit Program (SDP) account statement
or1099-INT?

Contact the Centralized Customer Support Unit toll free at 1-888-DFAS411 or 1-888-332-7411,
or commercial (216) 522-5096, or Defense Switching Network (DSN) 580-5096 (8:00 A.M. — 5:00 P.M. /
Eastern time)

52) Who is eligible to participate in the Savings Deposit Program?

Members of the Armed Forces serving in specified combat zones or in support of a contingency operation are
authorized to make deposits. Service members must be in receipt of Hostile Fire Pay and be deployed for at least

30 consecutive days or at least 1 day in each of 3 consecutive months. Contact your Finance Office to verify your
eligibility.

53) How may contributions be made?

Members may contribute up to 100% of their disposable (net) pay. Contributions may be made either by a savings
allotment with a unique bank routing number, or by cash (or check) deposit. Make the deposit or start the
allotment at your local pay office. When reviewing your statement, keep in mind that there may be a delay in the
posting of cash deposits.

54) What is the maximum that I may deposit?

There is no limit on the amount that may be contributed; however no interest is paid on amounts exceeding
$10,000.00. If you are depositing by allotment it will not stop automatically when the balance reaches $10,000.00.
You must monitor the balance. You may request the allotment be stopped. Army, Navy, Air Force, and Marine
members may also stop their SDP allotment in myPay from within the SDP Withdrawal Request option.

55) What is the interest rate?

The interest rate is 10% annually, earned at 2.5% per quarter. No interest is paid on amounts exceeding
$10,000.00. Deposits made by the 10th of a month will earn interest from the 1st of that month. Deposits made
after the 10th accrue interest from the first day of the following month. Your account will continue to earn interest
for 90 days after leaving the combat zone. Combat zone departure must be posted in order for interest accrual to
be correctly stopped.

56) Is interest taxable?

Yes, the interest is taxable. Combat zone rules do not apply. No federal or state tax is withheld. A 1099-INT is
issued no later than January 31st for Savings Deposit Program interest. If you do not receive your 1099-INT in the
mail you may contact Customer Support to request that it be reissued to you.

57) How may I withdraw the money in my account?

Non-myPay Applications

58) What do I do if other non-myPay applications/systems require me to use my SSN and myPay PIN, instead
of my myPay Login ID and Password?
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Some non-myPay applications may continue to require you to enter a current SSN and myPay PIN combination
for authentication even if you have already established a new Login ID and password. You may establish or
change your myPay PIN at any time using the myPay website. First log into myPay using your myPay Login ID
and Password, then from the myPay main menu under the Personal Setting Page option, click on the Change PIN
for use on systems other than myPay Web.

59) What if I do not know or have forgotten my PIN?

If you do not know or have forgotten your PIN, you may establish a new myPay PIN using the myPay website.
First log into myPay using your myPay Login ID and Password, then from the myPay main menu under the
Personal Setting Page option, click on the Change PIN for use on systems other than myPay Web.

60) If I lock myself out while trying to use my SSN/PIN combination on a non-myPay website or other
application, will I be locked out of the myPay website? How do I get my PIN account unsuspended?

If you suspend your PIN using a non-myPay application, wait 24 hours and then try again. You will still be able to
log into myPay Web with your Login ID and Password. Once logged in, you may reset/change your PIN. (First
log into myPay using your myPay Login ID and Password, then from the myPay main menu under the Personal
Setting Page option, click on the Change PIN for use on systems other than myPay Web.)

Logging Into myPay Using the On-Screen Keyboard Without a Mouse
61) How do I use the On-Screen Keyboard without a mouse?

The On-Screen Keyboard is one of many Security features myPay introduced to protect the security and privacy
of your data in our system. The advantage of using the On-Screen Keyboard, with keys that display in random
order each time you log on, is that others with potentially malicious intent are deterred from learning your
Password.

When you arrive at myPay and enter your Login ID, you will be presented the option to use the On-Screen
Keyboard to enter your Password.

To log in to myPay using the On-Screen Keyboard without a mouse:

1. Type your Login ID under Account Access on the myPay Home Page, and then press the hyperlink for the On-
Screen Keyboard.

2. You must rely on the “Tab” key and the “Space Bar” to enter your Password. You Cannot use the arrow keys to
make selections or move around within the On-Screen Keyboard. With some assistive software there may also be
browser access keys built into the application that can help speed up your data entry (see specifics on access keys
below).

a. To start entering your password using the On-Screen Keyboard, use the Tab key to move through the keys until
you arrive at the first number, letter or special character of your password. Press the Space Bar to select. The first
position of your password will appear (masked) in the text box.

b. The cursor will return to the first number in the first row of the On-Screen keyboard after selecting each
character.

c. Tab to each subsequent number, letter or special character of your password, and then press the Space Bar to
select.

d. After entering your complete password using the On-Screen Keyboard, press the Tab key to go to the “Accept/
Submit” button. Press the Space Bar to select, or use the built in access key combination of ALT 6 (if available) to
submit your password.
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e. In order to ensure all special character buttons are read back to users of Jaws for Windows, the punctuation
must be set to “all”. This allows for all of the keys on the On-Screen Keyboard to speak. If Jaws punctuation is set
to "some" or "none" then keys such as "!" and "_" will not speak, often all that is said is "button." To set
punctuation to all in Jaws the steps are as follows:

(1) Bring up "Jaws options" with an "insert+v" key.
(2) Either arrow down to punctuation level or press the letter <p> until you come to punctuation.

(3) If you enter an incorrect number, letter or special character using the On-Screen Keyboard, tab to the On-
Screen Keyboard Backspace button and then press the Space Bar to select it to erase the last position entered.

If you want to clear all the numbers/letters/characters you entered, tab to the Clear button on the On-Screen
Keyboard and select it by pressing the space bar.

(4) The "Return" key will exit from Jaws Options.

3. If you enter an incorrect number, letter or special character using the On-Screen Keyboard, tab to the On-
Screen Keyboard Backspace button and then press the Space Bar to select it to erase the last position entered.
If you want to clear all the numbers/letters/characters you entered, tab to the Clear button on the On-Screen
Keyboard and select it by pressing the space bar.

Using Access Keys to Speed Up Data Entry

If your browser supports access keys you can use them to more easily navigate through the On-Screen keyboard.
Access keys allow you to quickly jump to specified rows within the On-Screen Keyboard instead of tabbing
completely through the keyboard to enter your password. The following are commonly found access keys:

Alt 1: jump to row containing randomly presented Numeric Characters 1 thru 0.

Alt 2: jump to row containing randomly presented Symbolic Characters, i.e., !, =, -, etc,.
This row also contains the Backspace and Clear keys and Uppercase/Lowercase key.
Alt 3: jump to first row containing randomly presented Alpha Characters.

Alt 4: jump to second row containing randomly presented Alpha Characters.

Alt 5: jump to third row containing randomly presented Alpha Characters.

Alt 6: Submits your password after you finish entering all characters.

Printing and Saving your LES Without Using a Mouse
62) How do I print and save my LES without using a mouse?

There are several options available to save your LES to your computer within myPay without using a mouse. Near
the beginning of browser screens displaying your LES, you’ll find buttons labeled as Save, Print and Printer
Friendly Version.
SAVE Button
After tabbing to the Save Button and then pressing Enter the 'Save As' dialog box appears. This gives you the
option of saving your LES to your computer as a HTML or text file. Users with screen reader software such as
JAWS For Windows can use the application to read back the LES saved as either HTML or text.
PRINT Button

Provides normal functionality to print your LES on an available printer.
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PRINTER FRIENDLY VERSION Button

Pressing Enter on the Printer Friendly Version Button gives you several options to consider. If you have the Adobe
accessibility turned on in Adobe Acrobat, the program will try to read the LES. Acrobat may or may not display
the “Reading untagged Document” Dialog box. If you want to print your LES you need to answer cancel to this
dialog. Acrobat will then go ahead and display the LES on your screen without performing the accessibility
features of the program. Users of Jaws for Windows may hear the words “document not available.” In fact the
LES is really on the screen at this time. To go ahead and print, select print (Alt f) from the dropdown menu or just
press (Ctrl + p). The windows printer dialog will appear. Select OK and your LES will print.

SmartDocs Notifications
63) Beware of email Scams.

Customers should be aware of a scam in which recipients receive an email that claims to come from the Defense
Finance and Accounting Service (DFAS). The email states that the customer's password has been established or
changed with an attachment that contains malicious software (malware) that infects the intended victim’s
computers. To avoid malware do not click on any links, or open any attachments. Be vigilant and update your
computer with antivirus software and patches.

DFAS does send notifications when a Password has been established or changed in myPay from
SmartDocs@dfas.mil. Emails from SmartDocs@dfas.mil do not contain attachments of any kind. Ensure that
when you receive an email from DFAS that the email is being sent to an email address that you have registered
with DFAS.

myPay Mobile
64) What do I need to get started using the myPay mobile site?
You only need two things to get started:
* A mobile phone with a web browser. Phones that work best with the myPay mobile capability include the iPhone,
Android (DROID), Blackberry and other Windows mobile devices.
* A myPay user account and the same Login ID and password you currently use to manage your myPay account on

your computer.

Not enrolled? Go online to https://mypay.dfas.mil/mypay.aspx and click on the “Create an Account” link in the
LOG IN section on the left side of the screen. Follow the instructions for creating your Login ID and Password.

65) Is there a special URL for the mobile site?

Simply visit https://mypay.dfas.mil. We can automatically detect if you are using your iPhone, Android,
Blackberry or other Windows mobile device, and will load a mobile version of the site.

66) What is the mobile site?

The myPay mobile capability makes it possible for you to manage your account on the go, by making key
information and capabilities accessible from a mobile phone.

67) Will myPay have an Application (APP) Download?
Not at this time. There are a limited number of SmartPhones that offer Application download capabilities. Since

myPay services over 6 million customers, the Mobile capability offers the ability for a wider range of users to
access myPay via the SmartPhone.
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68) How can I manage my account on the mobile site?

The mobile site delivers key account information to your fingertips. On your mobile phone, you will be able to
instantly access:

* Your pay statements (Leave and Earnings, Retiree Account Statement, etc.)
*  Access to the myPay full Site for transactions (Change Allotment, etc.) and tax statements (W-2, 1099)

69) What devices can I use to access the mobile site?
The mobile site can be accessed from mobile phones that support a mobile browser. Phones that work best with
the myPay mobile capability include the iPhone, Android (DROID), Blackberry and other Windows mobile
devices. Please reference your mobile phone’s user manual to learn more about using your web browser on your
mobile phone. In addition, make sure that your mobile phone has cookies enabled.
The Apple iPod touch® can also access the mobile site, as long as you are connected to a Wi-Fi network.

70) Which carriers support the mobile site?

You can access the mobile site from almost any carrier network. Using a mobile web browser may require a data
plan. Please contact your carrier for specific pricing information for your data plan.

71) Can I access the mobile site while travelling abroad?
Yes, but be aware of roaming fees. Please contact your carrier for specific pricing information.

72) What is my myPay mobile site Login ID and Password?
Use the same Login ID and Password you use to access https://mypay.dfas.mil on the computer. If you do not
have a Login ID and Password, or you have forgotten your Login ID or Password, go online to https://
mypay.dfas.mil, click on the applicable link in the LOG IN section on the left side of the screen and follow the
instructions.

73) How is the mobile site different from the regular site?

The homepage has been optimized for your mobile phone and key account information and management options
are delivered in an easy to read format.

74) How secure is my information?
myPay Mobile uses the same security standards as our myPay full site:

* 128-bit encryption to protect your sensitive information

* Uses firewall and intrusion detection software to block outsiders

* Features internationally recognized security standards
To protect all data sent to and from myPay, your information is transmitted using end-to-end encryption and is
not cached.

However, please note that myPay does not operate or control, and thus cannot guarantee, the wireless networks
used to access the mobile site. Carrier protocols may vary. Check with your wireless service provider for
information about their privacy and security practices.

Note: NEVER store confidential information (i.e., myPay Password) on the mobile device and NEVER divulge
the Password to others.
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75) Why won’t the mobile site load on my mobile device?

Please check your reception level. A low reception level could cause spotty or extremely slow access—or even
prevent you from accessing the mobile site at all.

If you are on a BlackBerry® device, try using “Internet Browser” instead of the default “BlackBerry Browser.”

If your reception is fine, another possibility is that we are experiencing a technical problem on our end. Please call
the DFAS Customer Care Center at 1-888-332-7411 if you wish to check the status of the mobile site, or need
further help to access your account.

Also, the problem could be with your mobile device. Please contact your carrier for specific information.
76) Which browser should I use on a BlackBerry® device?

Please use the “Internet Browser” that is pre-installed on the device. To make it your default browser, select
Options > Advanced Options > Browser. Then choose Internet Browser.

Most BlackBerry devices use the “BlackBerry Browser” by default, which is not compatible with many firewalls.
Using it could prevent you from accessing the mobile site.

77) Why am I having trouble entering my Login ID and Password?
SmartCard Login
78) What is SmartCard Login?

SmartCard Login allows military members, military retirees who are Department of Defense (DoD) contractors
and have been issued a SmartCard, DoD civilian employees, and Department of Health and Human Services
(HHS) and Veterans Administration (VA) employees to log in to myPay using their DoD Common Access Card
(CAC) or HHS or VA Personal Identity Verification (PIV), also known as SmartCards. When using SmartCard
Login, these customers do not need to enter a Login ID and Password.

79) What if I don’t have a CAC or PIV?

You can still access myPay using your Login ID and Password.
80) How do I register my CAC or PIV?

Follow these easy step-by-step instructions:

*  You will need a computer with a SmartCard reader.

* Ensure your CAC or PIV is in the computer and select the “SmartCard Login” button on the myPay home
page at https://mypay.dfas.mil.

* Select the certificate associated with your CAC or PIV. Select only one certificate if two or more are
displayed

*  You will be prompted to enter the Personal Identification Number (PIN) associated with your CAC or PIV.
Enter your PIN and select “OK”

* DoD CAC users will then be asked to enter their Social Security Number (SSN) twice.

* After entering their PIN, HHS and VA PIV users will be advised they must self-register. Please refer to FAQ
#100.

*  Your SmartCard registration will be confirmed. You may use it to log in the next time you access myPay.
(Note: the name displayed is the name registered on your CAC or PIV)

* Ifyoudo not yet have a Login ID, you will be prompted to enter a Login ID and Password
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* Select “Main” to continue
81) What if my SSN does not match the pre-registered information?
For DoD CAC users, myPay performs a database check at the Defense Manpower Data Center (DMDC).

If you receive the error your SSN does not match the information, please contact your RAPIDS Station Point of
Contact, your Personnel Center or the DMDC Help Desk at (800) 538-9552 to have your records corrected.

To locate the nearest ID card office you can use the RAPIDS Locator Web site.
You can still access myPay using your Login ID and Password until the records are corrected.
This information is not applicable for HHS and VA PIV users.

82) What if I don’t know my CAC or PIV PIN or my CAC or PIV is Expired or Revoked?

For DoD CAC users, please contact your RAPIDS Station Point of Contact, your Personnel Center or the DMDC
Help Desk at (800) 538-9552 to have your records corrected.

You can still access myPay using your Login ID and Password until the records are corrected.

To locate the nearest ID card office you can use the RAPIDS Locator Web site.

HHS PIV users:

General questions about PIV SmartCards and HSPD-12: Contact HSPD-12@HHS.gov.
AMS Login: Contact the ONE DHHS Help Desk at 1-888-ONE-DHHS (1-888-663-3447).
PIV SmartCard: Contact your local security office for issuance or troubleshooting.

SmartCard Reader: Contact your local IT Service Desk or go to the "Need Help?" link on the AMS login
page to access IT Service Desk contact information.

VA PIV users:
* General questions about VA PIV SmartCards: Contact the VA Information Technology Support Desk at
1-888-596-4357 for hardware or software problems.
* VA HSPD-12 PMO INTRANET: vaww.va.gov/pivproject
*  FREQUENTLY ASKED QUESTIONS: http://va.gov/PIVPROJECT/fag.asp
* PIV SYSTEM TECHNICAL SUPPORT: 1-916-692-7460 (option 2); pivhelprequests@va.gov
* SmartCard Reader: Contact your local IT Service Help Desk
83) What if I am a new employee?
If you are a new employee/member your myPay account may not be established. If you enter myPay with your
DoD or HHS or VA SmartCard and your account is not established you will be advised to try your SmartCard
again in 30-45 days.
84) Why do I have to setup a Login ID and Password if I access myPay using my DoD CAC,HHS or VA PIV?

You will still need a Login ID and Password if you access myPay from a computer or mobile phone that is not
SmartCard enabled.

85) What happens if myPay does not have my DoD CAC, HHS or VA PIV information?
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If you select “SmartCard Login” button and myPay does not have your CAC or PIV, you will be advised to access
myPay using your Login ID and Password and given the option to self-register your CAC or PIV.

*  Enter your myPay Login ID and Password
*  The Self-Registration screen will display your name.
o Ifthe name is NOT yours, you should exit the system immediately.
o Ifthe name is yours, select “Yes” to register your SmartCard
*  Your SmartCard is registered and you may use it the next time you access myPay

* Select “Main” to continue.

Military Pay Tables
The agency responsible for paying America’s service members is the Defense Finance and Accounting Service (DFAS).
Military Pay Tables — 1949 to 2013

To find pay table for the past 50+ years, visit: http://www.dfas.mil/militarymembers/payentitlements/
militarypaytables.html

On August 30, 2013, President Obama informed Congress that he will be exercising his powers as President to cap the
military's pay at one-percent for 2014. Congress can still override the President's cap and send him the 1.8% per current
Title 37 mandate; however, Congress would need to find the additional funding required to make this a reality, and finding
the additional $580 million will be difficult with the state of today's economy.

The basic pay charts below are for active and reserve components of the United States Army, Navy, Marines, Air Force,
Coast Guard and National Guard for the calendar year 2014, beginning January 1st if approved. The pay rates are monthly
amounts rounded to the nearest U.S. dollar.

2014 Proposed Base Pay for Enlisted Members

lPav-Grade ILess-than-2 Over-2 Over-3 Over-4 Over-6
E-9 - - - - -

[E-8 - - - - -

[E-7 $2,752 $3,004 $3,119 $3,272 $3.391
IE-6 $2.381 $2.620 $2,735 $2,848 $2.965
[E-5 $2.181 $2.327 $2.,440 $2.555 $2,735
[E-4 $2,000 $2,102 $2.216 $2,328 $2.,427
IE-3 $1,805 $1,919 $2,035 $2,035 $2,035
E-2 $1,717 $1,717 $1,717 $1,717 $1,717
[E-1 $1,532 $1,532 $1,532 $1,532 $1,532
|Pav-Grade Over-8 Over-10 Over-12 Over-14 Over-16
IE-9 $4.837 $4,946 $5,084 $5,247
IE-8 $3,959 $4,134 $4,243 $4373 $4514
IE-7 $3,595 $3,710 $3.914 $4,084 $4,200
IE-6 $3,228 $3,331 $3,530 $3,591 $3,636
[E-5 $2,923 $3.076 $3,095 $3,095 $3,095
E-4 $2.,427 $2,427 $2,427 $2,427 $2.,427
IE-3 $2,035 $2,035 $2,035 $2,035 $2,035
[E-2 $1,717 $1,717 $1,717 $1,717 $1,717
IE-1 $1,532 $1,532 $1,532 $1,532 $1,532
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IPay-Grade Over-18 Over-20 Over-22 Over-24 Over-26
[E-9 $5,411 $5,674 $5,896 $6,129 $6,487
IE-8 $4,768 $4,896 $5,115 $5,237 $5,536
[E-7 $4,324 $4,372 $4,532 $4,619 $4,947
[E-6 $3,687 $3,687 $3,687 $3,687 $3,687
[E-5 $3,095 $3,095 $3,095 $3,095 $3,095
IE-4 $2,427 $2,427 $2,427 $2,427 $2,427
IE-3 $2,035 $2,035 $2,035 $2,035 $2,035
[E-2 $1,717 $1,717 $1,717 $1,717 $1,717
IE-1 $1,532 $1,532 $1,532 $1,532 $1,532
Proposed 2014 Base Pay for Warrant Officers

IPay-Grade Under-2 Over-2 Over-3 Over-4 Over-6
IW-5 - - - - -

'W-4 $4,003 $4,306 $4,430 $4,552 $4,761
'W-3 $3,656 $3,808 $3,964 $4,016 $4,179
IW-2 $3,235 $3,541 $3,635 $3,700 $3,910
IW-1 $2,840 $3,145 $3,227 $3,401 $3,607
[Pay-Grade Over-8 Over-10 Over-12 Over-14 Over-16
IW-5 - - - - -

'W-4 $4,968 $5,178 $5,494 $5,771 $6,034
'W-3 $4,502 $4,837 $4,995 $5,178 $5,366
IW-2 $4,236 $4,397 $4,557 $4,751 $4,903
IW-1 $3,909 $4,051 $4,248 $4,442 $4,595
[Pay-Grade Over-18 Over-20 Over-22 Over-24 Over-26
IW-5 $7,118 $7,479 $7,748 $8,046
'W-4 $6,249 $6,459 $6,768 $7,022 $7,311
'W-3 $5,704 $5,933 $6,070 $6,215 $6,413
IW-2 $5,041 $5,205 $5,314 $5,400 $5,400
IW-1 $4,736 $4,907 $4,907 $4,907 $4,907

Sources: http://usmilitary.about.com/od/payandbenefits/a/Fy2014ProposeMilPayEnl.htm
http://usmilitary.about.com/od/payandbenefits/a/FY2014ProposedMilPayRatesWO.htm
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Allowances

Basic Allowance for Subsistence (BAS)

BAS is meant to offset costs for a member's meals. This allowance is based in the historic origins of the military in which
the military provided room and board (or rations) as part of a member's pay. This allowance is not intended to offset the
costs of meals for family members.

Beginning on January 1, 2002, all enlisted members get full BAS, but pay for their meals (including those provided by the
government). This is the culmination of the BAS Reform transition period.

Because BAS is intended to provide meals for the service member, its level is linked to the price of food. Therefore, each
year it is adjusted based upon the increase of the price of food as measured by the USDA food cost index. This is why the
increase to BAS will not necessarily be the same percentage as that applied to the increase in the pay table, as annual pay
raises are linked to the increase of private sector wages.

2012-2014 BAS (Basic Allowance for Subsistence) Comparison

Year |Proposed Increase |Actual Increase |[Enlisted BAS Officers BAS
2014 [3.40% IN/A IN/A IN/A

2013 [3.40% 1.09% $352.27 $242.60
2012 [3.40% 7.20% $348.44 $239.96

Read more: http://militarybenefits.info/2014-bas-basic-allowance-for-subsistence-rates/#ixzz2kw8U7vSr

Basic Allowance for Housing (BAH)

BAH is an allowance to offset the cost of housing when you do not receive government-provided housing. Your BAH
depends upon your location, pay grade and whether you have dependents. BAH rates are set by surveying the cost of
rental properties in each geographic location. The rates are established such that members in each pay grade, independent
of location, pay approximately the same out-of-pocket costs. Therefore, BAH rates in high-cost areas will be much greater
than those in low-cost areas. BAH rates are explained at https://www.defensetravel.dod.mil/site/bah.cfm and service
members can calculate their BAH payment here: http://www.defensetravel.dod.mil/site/bahCalc.cfm

Additionally, there are different types of BAH to compensate for special situations.
BAH Levels and Increases

The Secretary of Defense announced a major FY2001 Budget initiative to eliminate out-of-pocket costs for off-base
housing in the United States. This action reduced service members' out-of-pocket costs for housing from an average of
18.8 percent of monthly housing costs in 2000 to 15 percent in 2001, with continued reductions each year thereafter.
Average out-of-pocket costs were entirely eliminated in 2005.

Average rental costs in particular locations fluctuate, both up and down. Until 2005 when the transition from the old Basic
Allowance for Quarters and Variable Housing Allowance (BAQ/VHA) to BAH is complete, BAH rates did not decrease at
any location. Beginning in 2006, BAH rates for an area may follow both the increases and decreases of average rental
costs, but no individual’s rate will decrease

Different Types of BAH
There are several types of BAH to satisfy various housing situations that occur among military members. In general, the

amount of BAH you receive depends on your location, pay grade, and whether you have dependents. Under most
circumstances, you receive BAH for the location where you are assigned, not where you live. Additionally, you may be
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entitled to some BAH amounts if you are residing separately from your dependents. This occurs in situations involving
unaccompanied overseas tours or having a dependent child that resides with a former spouse. The rules regarding these
situations can become quite complex. Consult your Finance Office if you are in one of these situations. Each type of BAH
is described below.

BAH With Dependents and BAH Without Dependents

A member with permanent duty within the 50 United States, who is not furnished government housing, is eligible for
Basic Allowance for Housing (BAH), based on the member's dependency status at the permanent duty ZIP Code. A
member stationed overseas, including U.S. protectorates, who is not furnished government housing, is eligible for
Overseas Housing Allowance (OHA) based on the member's dependency status. If a member is serving an
UNACCOMPANIED overseas tour, the member is eligible for BAH at the "with dependents" rate, based on the
dependent's US residence ZIP Code, plus OHA at the "without dependents" rate, if the member is not furnished
government housing overseas.

Partial BAH
A member without dependents who is living in government quarters is entitled to a Partial BAH.
BAH II (Reserve Component/Transit)

BAH-II (RC/T) is the housing allowance for members in particular circumstances, for example, reservists on active duty
less than 30 days. It also applies when a member is in transit from selected areas where no prior BAH rate existed. It does
not vary by geographic location. BAH-II (RC/T) was set based on the old Basic Allowance for Quarters (BAQ), which
was based on the national average for housing. BAH-II is published annually and is determined by increasing the previous
year's table by the percentage growth of housing costs.

BAH-Diff

BAH-DIFF is the housing allowance amount for a member who is assigned to single-type quarters and who is authorized
a basic allowance for housing solely by reason of the member's payment of child support. A member is not entitled to
BAH-DIFF if the monthly rate of that child support is less than the BAH-DIFF. BAH-DIFF is determined by the SECDEF
and was equal to the difference between BAH-II with dependents and BAH-II without dependents in 1997 for the
member's grade. BAH-Diff is published annually and is determined by increasing the previous year's table by the
percentage growth of the military pay raise. For more information contact your finance office or consult Section 260416,
Chapter 26 FMR.

Frequently Asked Questions
1) Who is eligible for BAH?

A member assigned to permanent duty within the 50 United States, who is not furnished government housing, is
eligible for a Basic Allowance for Housing (BAH), based on the member's dependency status at the permanent
duty station ZIP Code. A member stationed overseas (except in Hawai’i and Alaska), including U.S. protectorates,
who is not furnished government housing, is eligible for an Overseas Housing Allowance (OHA) based on the
member's dependency status. If a member is serving an